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  Welcome
Welcome to the Getting Started with ZBrush guide and many thanks for your 

interest in ZBrush! 

This step by step guide will walk you through the creative world of ZBrush from 

the basics to sculpting, painting and on to finishing off your art with ZBrush’s 

powerful render engine. The Getting Started with ZBrush guide is a live 

interactive document to use from your computer, containing links to various 

videos, tutorials, and locations of the numerous Pixologic web pages. Be sure 

to keep your eyes open and minds focused to follow these links and enhance 

your ZBrush experience.

ZBrush is a software application that was Created by Artists for Artists. 

Since its inception in 1999 the award-winning ZBrush has established itself as 

the innovative Standard of the 2D/2.5D digital painting and 3D digital modeling 

worlds. ZBrush will enable you as an artist to Create, Innovate, Inspire 

and open up exciting new digital worlds for yourself that you might never 

have believed were possible. By applying its intuitive features and powerful 

sculpting and illustration capabilities, ZBrush has enabled digital hobbyists 

and professional artists From Over 10 Industries to shatter the barriers of 

creativity. Leave the usual technical restraints behind so that you can focus 

solely on your creation!

ZBrush is widely acknowledged and celebrated for its ground-breaking use 

in the conceptualization and realization of characters, environmental effects 

and visual effects in many blockbuster films and video games including Avatar 

(20th Century Fox), Lord of the Rings (Weta Digital), Pirates of the Caribbean 

(I.L.M.), Gears of War (Epic Games), Assassins Creed (Digic Pictures) and 

Uncharted (Naughty Dog), just to name a few.

http://www.pixologic.com/interview/
http://www.pixologic.com/zbrush/features/zbrush4/overview/
http://www.pixologic.com/home.php
http://www.pixologic.com/zbrush/industry/
http://www.zbrushcentral.com/showthread.php?t=079195
http://www.zbrushcentral.com/showthread.php?t=079195
http://www.pixologic.com/interview/archive/weta/
http://www.pixologic.com/interview/archive/ilm-pirates/
http://www.pixologic.com/interview/archive/ilm-pirates/
http://www.pixologic.com/interview/epic/1/
http://www.zbrushcentral.com/showthread.php?t=73117
http://www.zbrushcentral.com/showthread.php?t=079141
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Frederik Storm

Caio Cesar

David Lesperance

This document will take you through various videos, articles, tutorials, and 

images to inspire your journey. Most importantly, our goal is for you to 

understand how to best use ZBrush in your own artistic way. If you master 

the basic philosophies and techniques behind ZBrush, you will be able to 

apply those methods to create anything you can imagine. 
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Maarten Verhoeven

See what our ZBrush Community is doing today....

Be inspired at ZBrush Central

Turntable Gallery

Artist Gallery

http://www.zbrushcentral.com
http://www.pixologic.com/zbrush/gallery/
http://www.pixologic.com/turntable/
http://www.pixologic.com/zbrush/gallery/2010/
http://www.pixologic.com/turntable/
http://www.zbrushcentral.com/featured2col.php
http://zbrushcentral.com
http://www.zbrushcentral.com/featured2col.php
http://www.pixologic.com/turntable/
http://www.pixologic.com/zbrush/gallery/
http://www.pixologic.com/zbrush/gallery/2010/
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Resources You Will Use Most
Official learning and training content:      

The ZBrush Documentation - You will find in your ZBrush/Documentation folder a Starting 
Guide, a What’s New Guide and a Tutorial Guide. Don’t forget to check them for in-depth 
information about ZBrush 4 features and tips and tricks!

Our Resources:      

Pixologic.com - The Pixologic home site is updated regularly with company and product 
news, ZBrush artist gallery images, 3D Turntables, company/artist interviews, and much more.

Docs.Pixologic.com - Online ZBrush documentation  
with all the functions listed, including the plugins, short-cuts and more!

ZClassroom - Your video training center at Pixologic.com!  
Hours of free training video dedicated to ZBrush available 24/7.

ZBrushCentral.com - Our community forum with more than 240,000 members and counting! 
Some of the best artists from around the world come here to post their ZBrush art and 
share their “secrets”. Ask your questions, post your works-in-progress, and/or your finished 
creations. Interact with the community to improve your skills and help others when possible. As 
a ZBrush user you should definitely register at ZBrushCentral and view the daily postings! (It’s 
free.) 

Note: New plugins and updates for ZBrush are always  
announced first at ZBrushCentral.com! 

The ZBlog - This is our official blog, with all the latest news about ZBrush, Sculptris and 
Pixologic. Check it on a regular basis. Even better, subscribe to its RSS feed!

Follow us on Twitter! Daily news, great threads to visit at ZBrushCentral  
and other useful information – all sent directly to you.

Become a part of the ZBrush social network on our Facebook Fan Page.

Don’t miss out on the ZBrush videos on YouTube.

LET’S BEGIN……

http://www.youtube.com/user/ZBRUSHatPIXOLOGIC
http://twitter.com/pixologic/
http://www.facebook.com/pages/Pixologic/154468544767
http://www.pixologic.com/home.php
http://docs.pixologic.com
http://www.pixologic.com/zclassroom/homeroom/
http://www.zbrushcentral.com/
http://www.pixologic.com/blog/
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Use ShadowBox to create your 
next vehicle with Steve Warner

Imagery Courtesy of David Giraud and Steambot Studios

Using this Course:

Each section of this course uses a combination of text, images, and links to ZBrush tutorial 
videos and resources on the Web. To get the most out of this curriculum, we recommend 
that you follow ALL of the links provided and thoroughly investigate the pages they lead to. 
The Pixologic Website, ZClassroom, and ZBrushCentral are the most powerful tools 
available to the ZBrush artist - containing tutorials, tips, and hints straight from leading 
professionals and from the experts at Pixologic. The links in this course will take you to the 
most essential pages in these growing resources. But don’t stop there, keep exploring these 
sites to get the most out of your ZBrush experience!

Key Things to Remember :

Any time you see Underlined, Orange Text , this is a hyperlink to a 
resource in ZClassroom, ZBrushCentral or on Pixologic .com.  
These links are essential to the curriculum.

Orange buttons and text, like the example above, can be found at the end 
of some sections. These are links to insider tips and tricks written by Top 
ZBrush Artists.

Orange boxes with the icon pictured on the left can be found 
at the end of some sections. These boxes contain time-saving 
keyboard shortcuts for the tools discussed in the sections.

http://www.zbrushcentral.com/showthread.php?t=91827
http://www.pixologic.com/home.php
http://www.pixologic.com/zclassroom/homeroom/
http://www.zbrushcentral.com/
http://www.pixologic.com/home.php
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G et t i ng
S t ar t e d

Table of Contents
This course will be broken up into 5 sections: 

Chapter 1: Getting Started
Learn the basics of ZBrush: What Edit mode is and how to use the 
interface.

Chapter 2: Let’s Get Sculpting
A walk through the various 2D, 2.5D, and 3D brushes. Also covered are the 
various innovative tools that enable artists of today to create their digital 
masterpieces.

Chapter 3: Paint it up
Focuses on the 2D and 2.5D side of ZBrush. With the painting system in 
ZBrush, you as an artist can Illustrate, Texture, and Conceptualize anything.

Chapter 4: Bring your Work to Life
With tools such as ZSphere Rigging, TransPose, and Timeline you can 
bring any character to life.

Chapter 5: Polishing your Work
With ZBrush’s rendering and materials systems you will make any art pop 
off the screen.



Do more, Do it in...

Imagery Courtesy of Alex Zozhanov

G et t i ng
S t ar t e d

Chapter 1:
Chapter 2

Start

Chapter 3

Chapter 4

Chapter 5



Do more, Do it in...

10Imagery Courtesy of Ryan Kingslien

ZBrush User Interface

Before you can create, you must first be comfortable with the UI. ZBrush is a unique blend of 
2D, 2.5D and 3D features. For this reason, the ZBrush interface has been designed to let you 
be “in control” with it’s customizable features. 

The link below will walk you through basic videos regarding ZBrush’s navigation and 
concepts such as parametric objects, masking, polypaint and much more.

http://www.pixologic.com/zclassroom/homeroom

( The movies are each devoted to a specific topic. To navigate between them, 
use the scroll bar directly beneath the main movie. )

See Daniel Williams completely customize ZBrush’s UI HERE
Check out how to create your own Palette HERE

Startup UI Layout

The following two pages show the Standard ZBrush UI configuration. Remember that other 
UI configurations can be selected using the buttons on the top right side of the title bar. 
ZBrush’s UI is completely customizable for a dynamic and powerful workflow. The Shelf 
is a great resource for storing your most used elements in ZBrush. Remember to visit 
Preferences>Config>Store Config to make sure ZBrush will always open with the same UI 
every time it is launched on the same computer system.

Learn what every button can do for you in ZBrush by holding CTRL and scrolling over any 
part of the interface. A pop window will appear giving a short description of the button or 
slider. 

http://www.pixologic.com/zclassroom/homeroom/
http://www.zbrushcentral.com/showthread.php?t=95087
http://www.zbrushcentral.com/showthread.php?t=61676&page=10&pp=15


Do more, Do it in...

Palettes

All Palettes are listed in this bar 
in alphabetical order and can be 
displayed by name or by icon. To open 
a Palette, simply hover your mouse/tablet pen 
over it. All Palettes can also be docked into 
either of the Trays on the right or left of the 
interface. Simply click the icon or click and 

The Shelf

The space surrounding the canvas provides 
a handy place to dock interface elements 
that you often use. This is completely 
customizable. Just activate Custom UI 
under the Preferences>Custom UI>Enable 
Customize. Hold the CTRL+ALT key, click on 
the element and drag it to where you want to 
place it. Note that only elements which exist 
at all times may be added in this manner. The 
standard UI will have quick icons to the Brush, 
Stroke, Alpha, Texture, and Material Palettes, 
along with the color swatch.

Lightbox

This is ZBrush’s built in browser. Lightbox 
can be used like your computer’s file explorer 
and help you navigate to different Brushes, 
Projects, Materials, etc. Store a short-cut for 
any system folder to be saved in one of the 
Lightbox folders for quick access to your very 
own folders. The Lightbox folders will be found 
in the ZBrush 4 root folder, e.g. The ZTools, 
ZMaterials, ZBrushes ZAlphas, etc., are folders 
that store all information for Lightbox.

The Edit Button

This is a key feature of ZBrush that will 
allow you to move in and out of 2D/2.5D 
and 3D mode. When the Edit button is 
pressed then you will be in 3D mode 
to freely sculpt, paint, and render your 
next creation. When the Edit button 
is unpressed you will be in 2D/2.5D 
mode which will allow you to create an 
Illustration that you never 
thought was possible.

Draw Mode

When the Draw button is pressed 
you will be able to use the various 
3D brushes to sculpt and paint 
your character or use the 2.5D 
brushes to change any image into a 
masterpiece. The Move, Scale, and 
Rotate will alter the shape of any 3D 
mesh or any Tool being used as a 
brush when in 2.5D 
mode. These three 
buttons will also 
move a model in 3D 
space when the Edit 
button is pressed.

Color Control

These three buttons and slider 
will control if Material, Color, 
or both will be applied to any 
mesh. The slider will control 
the intensity of Color being 
applied.

Your Brush:

Focal Shift
Draw Size

Timeline

Timeline will allow you to put your work in 
motion. This is also a great feature to use 
as an inventory system for storing SubTool 
visibility, tool position to the camera, 
document change, and so much more. 
Make sure to turn your Timeline on by 
visiting the Movie Palette>Timeline>Show. 
All Timeline short-cuts are also found by 
holding CTRL and scrolling over the Show 
button.

Customize Your ZBrush...



Tray
Clicking on the thin vertical bar 
on the left or right side of the 
screen will expand or collapse 
a Tray, which is used to keep 
often-used Palettes. Once a 
Palettes is docked in a Tray you 
will be able to move up & down 
the Palette to its Sub-Palettes.

Sculpting
The Zadd and Zsub controls 
whether a 3D brush will sculpt 
up or sculpt into any surface. 
The Intensity will control how 
quickly the surface will be built 
up or pushed in. The higher the 
Z Intensity slider is the stronger 
the effect. Hold the ALT key to 
switch between Zadd and Zsub.

Brush Controls
These two sliders control the 
size the brush will be and the 
roll off the brush will have to 
the surface.

Vert Point Count
This will display the current vertex 
point number of the visible selected 
SubTool and the total vertex count of 
all SubTools. ZBrush will only accept 
triangles or quad meshes. This number 
will be related to the millions of 
polygons each mesh has been divided 
into.

Sub-Palettes
There are several Sub-Palettes 
within Palettes. To expand a 
Sub-Palette simply click on any 
of the titles in a Palette. Once 
a title is clicked (e.g. Geometry 
in the Tool Palette) the Sub-
Palette will expand within the 
Palette itself. To close the Sub-
Palette click on the title again.

Navigation
ZBrush has a 2D/2.5D 
and 3D atmosphere. 
Keeping this in mind 
there are two sets of 
buttons for navigation. 
The buttons located 
on the top right that 
are labeled Scroll, 
Zoom, Actual, and 
AAHalf will control the 
document for use with 
ZBrush’s powerful 
2D/2.5D technology. 
These are  
the navigation buttons 
used when the Edit 
button is not pressed.

The buttons located 
near the bottom that 
are labeled Move, 
Scale, and Rotate 
will control the 
3D atmosphere of 
ZBrush. These are the 
navigation buttons 
used when the Edit 
button is pressed.

BPR Render brings work to life

Clipping brushes make any hard edge 

Xpose all SubTools with one click of the 

See-Through Mode
Sometimes as you work you 
might find yourself searching 
for reference images on 
the internet or referencing 
an image already loaded 
into another program. See-
Through will allow you to 
apply a transparency to the 
whole application of ZBrush 
for better viewing of your 
reference.

Quicksave with Autosave
Saving your work has 
been streamlined with the 
addition of Quick Save. 
If you have ever become 
so focused on creating 
that you’ve lost track of 
time and forgotten to 
save your work you will 
appreciate the new Auto 
Save feature.

Dynamic Brush Size
Makes it possible for the brush size to dynamically change 
as the model moves closer or further away from the camera.
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shortcuts: 
T = Edit
W= Move
R = Rotate
E = Scale

3D Primitives

Imagery Courtesy of Fabio Paiva

What is Edit Mode?
The video titled “Review of the UI” will give you an understanding  
of ZBrush’s innovative interface. This concept is key to creating characters  
and scenes in ZBrush.

     

Initialize ZBrush:
The video titled “Initialize ZBrush” will explain how to reset your settings to default. Think 

of the Initialize function as a return to default option.

Tray
Clicking on the thin vertical bar 
on the left or right side of the 
screen will expand or collapse 
a Tray, which is used to keep 
often-used Palettes. Once a 
Palettes is docked in a Tray you 
will be able to move up & down 
the Palette to its Sub-Palettes.

http://www.pixologic.com/zclassroom/homeroom/lesson/zbrush-introduction/
http://www.pixologic.com/zclassroom/homeroom/lesson/zbrush-introduction/
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shortcuts: 
CTRL+D = Add a subdivision level
D = Step up your subdivision levels
Shift+D = Step down your subdivision levels

Imagery Courtesy of Kris Costa

What Subdivision Levels Are:

A key video to watch is the one titled “Subdividing”. This will demonstrate the power of 
being able to adjust a model at multiple resolution levels and in a non-linear fashion. This 
is what we call Multi-Resolution Mesh Editing. When a mesh is divided (quadrupling the 
mesh resolution), ZBrush will retain the previous level or levels. This will allow you to switch 
between levels at any time.

However, the power of ZBrush’s innovative Multi-Resolution Mesh Editing is in being able to 
adjust to a lower subdivision level, make a broad scale change to your mesh, then return to a 
higher subdivision level where fine detail can be added with no loss of quality to the mesh and 
with all changes made on the lower subdivision level retained in the higher subdivision. 

http://www.pixologic.com/zclassroom/homeroom/lesson/zbrush-introduction/
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shortcuts: 
CTRL = Select your Masking Brush
Ctrl+Alt = Toggle the Masking Brush to unmask instead

Imagery Courtesy of Tomasz Strzalkowski

3D Brush Basics:

Learn the many ways in which you can adjust your sculpting brushes to meet your changing 
sculpting needs: 

The video titled “Brush Adjustments” will walk you through the basics of brush usage and 
adjusting its size.

The video titled “Strokes and Alphas” shows you how easy it is to create detail with 
ZBrush. A simple grayscale image can dramatically change the effect of your brush strokes!

The “Masking” video presents how easy it is to 
create wrinkles, isolate details to only one part of 
the mesh, or use masking for polygon selection.

There are 5 Masking Brushes to choose from. 
Hold Ctrl (or Command on MAC) to view the 
default Masking Brush. While it is selected, 
click the Brush thumbnail (on the left side of the 
canvas) to choose a different Masking Brush: 

• MaskCircle

• MaskCurve

• MaskLasso

• MaskPen

• MaskRectangle

http://www.pixologic.com/zclassroom/homeroom/lesson/zbrush-introduction/
http://www.pixologic.com/zclassroom/homeroom/lesson/zbrush-introduction/
http://www.pixologic.com/zclassroom/homeroom/lesson/zbrush-introduction/


Do more, Do it in...

16Imagery Courtesy of David Lesperance

Curve Method

Curve Tube Brushes: Curve Line Tube and 
Curve Multitube Brushes
The curve line tube function quickly generates 

tube 
geometry 
from the lines 
you draw.  
You can still 

edit and manipulate the form, shape, number 
of editable points on your curve and the size of 
these tubes by changing the brush size while 
the brush size indicator is red. In conjunction 
with this, the Curve MultiTube brush generates 
multiple curves and still allows users to retain 
control over editing the various curves drawn on 
the canvas. 

Curve Lathe/ Curve Multilathe

The Curve Lathe brush produces geometric 
outputs with an imbedded revolve. 

Curve Tube
The Curve Tube Brush 
generates tubular geometry 
and allows for continuous 
editing of the active tubes in 

your scene. By changing the brush size you can 
dramatically control the size parameters of your 
active tubes.

Curve Tube Snap
The Curve Tube Snap brush 
generates tubes in the 
same fashion as the Curve 
Tube brush but snaps the 
geometry to the existing mesh in your ZBrush 
canvas.

Curve Surface
The Curve Surface Brush 
generates geometry based 
on curves and snaps to 
the surface of your model. 
Curves drawn with the Curve Surface Brush will 
remain in an editable state until you draw out the 
next curve. By changing your brush size, you 
can actively change the size of the most recently 
generated geometry.

Curve TriFill
The Curve TriFill Brush will 
generate geometry based 
on the curves you draw on 
the ZBrush canvas. The 
geometry derived from using the Curve TriFill 
brush is triangulated. Curves retain interactivity 
by allowing you to make adjustments to size 
and the overall number of points on your active 
curve.size, you can actively change the size of 
the most recently generated geometry.
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Learn how to use the Curv e Tri 
Fill Brush

Learn more about new brushes in 
ZBrush 4r4

tips: 
• Curve Method Brushes 
work best when used 
in conjunction with 
Dynamesh. Allowing you 
to generate complex, 
unique forms fluidly and 
with flexability. 

• Curve Mode can be 
added to your custom 
brush by simply activating 
it from the stroke palette

Imagery Courtesy of Marten Verhoeven 

Curve Quad
Similar to the Curve TriFill 
Brush and differing only in 
output, the Curve QuadFill 
Brush generates geometry 

with mostly four sided faces in its composition. 
Generating geometry is as easy as drawing out 
a curve on the ZBrush canvas. Again, curves 
generated with this brush retain the ability to edit 
and manipulate overall size and number of curve 
points while still active.

http://www.pixologic.com/zclassroom/homeroom/lesson/3d-brushes/#curve-tri-fill
http://www.pixologic.com/zclassroom/homeroom/lesson/3d-brushes/
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Click outside the white line  
(red highlight) to move 
your model when it fills the 
whole canvas

Imagery Courtesy of Scott Patton

Navigation in Edit Mode:

Buttons to the right of the canvas allow you to move, scale and rotate your model on the 
canvas. Even faster are the keyboard shortcuts for these features - with just a little practice, 
they will make it very easy to adjust your model in front of the camera. 

To Move your model:

Hold Alt while you click and drag anywhere on the canvas (Option key for MAC 
users). 

Be sure to click on empty space so that ZBrush knows you wish to move the 
model rather than sculpt. If your model is scaled so large that it fills the viewport, 
click outside the canvas or outside the white line that frames the viewport on a 
very large canvas.

To Rotate your model:
Click and drag anywhere on the empty canvas.

To Scale your model:

Hold Alt, press and hold the mouse button while the cursor is over an empty part 
of the canvas, release Alt, then drag up or down. This maneuver takes a little 
practice to get down, but is very efficient once mastered.
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Right-Click Navigation:

As an alternative to navigation with keyboard shortcuts, ZBrush also offers a feature called 
Right-Click Navigation. Turn this on in the Preferences>Interface menu if you would like to 
use it. 

A key difference is that with this navigation method you can click while the cursor is over the 
model.

Move: Hold Alt while you right-click & drag 

Scale: Hold Ctrl while you right-click & drag 

Rotate: Simply right-click & drag without pressing any keys 

If you wish to make this your default navigation method, be sure that it is turned on and then 
save your preference setting by pressing Ctrl+Shift+I.

ZBrush Shortcuts List:

A complete list of all ZBrush shortcuts is found HERE

http://docs.pixologic.com/user-guide/keyboard-shortcuts/shortcuts-by-palette/
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Tools, Projects and Documents:   
What You Save is What You Get

ZBrush uses different file formats for saving and loading different types of data. It is 
important to understand these formats so that you always get what you expect when you 
save your work.

The video titled “Saving” describes the different formats and where the save/load 
buttons are found. 

Quicksave with Autosave: This feature supplements your regular saves by creating uniquely 
named backups which can be made with or without the Project History. Each time a 
QuickSave is called for, it creates a new project with incremental numbering with quick 
access through LightBox.

If you step away from your computer or switch to another application for a few minutes, 
ZBrush will add a new QuickSave to the existing series. This turns QuickSave into an  
Auto Save process!

This feature isn’t limited to inactivity either. You can also set ZBrush to automatically 
perform a QuickSave after a specified amount of time has passed since your last save.

http://www.pixologic.com/zclassroom/homeroom/lesson/zbrush-introduction/
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Document (ZBR file format): Saves pixols, only! This format is meant for creating  
illustrations. Any 3D data (if your model is in edit mode) is converted to  
2.5D data when saving as a document. (Document > Save or Document > Open)

Tool (ZTL file format): Saves polygons. Use this format to save a model as 3D data that you 
can continue to work with in edit mode later. This format will also save any maps that are 
applied to your SubTools via the Tool palette. (Tool > Save As or Tool > Load Tool)

ZBrush calls anything that can be used to add pixols to the canvas or modify 
pixols already on the canvas a “Tool”. Since 3D models can serve this purpose, 
they fall under this classification as well. Even though some tools are called 
“brushes”, they serve a very different purpose from sculpting brushes (which are 
found in the Brush palette). Click the link at the bottom of this page to find out 
more about Tools in ZBrush. 
 

ZProject (ZPR file format): New to ZBrush 4 is a format that saves considerably more data 
than the ZTL format does. This format will save the document settings including size and 
lighting, all materials that are used, the model itself and even the size/position/rotation of the 
model on the canvas, render settings, Timeline and more. In short, using this format allows 
you to return to ZBrush exactly where you left off. Keep in mind that this also results in a 
much larger file size than the ZTL or ZBR formats.  
(File > Save As or File > Open)

ZBrush calls a mesh a Tool, click the link below to find more out about Tools  
in ZBrush.

Learn more about Projects HERE

Learn more about Tools HERE

Learn more about Documents HERE

shortcuts: 
CTRL+S = Save project
CTRL+O = Load project

http://docs.pixologic.com/getting-started/basic-concepts/zbrush-projects/
http://docs.pixologic.com/reference-guide/tool/
http://docs.pixologic.com/reference-guide/document/
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Let’s Get 
Sculpting

Chapter 2:
Chapter 1

Start

Chapter 3

Chapter 4

Chapter 5
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Let’s Get 
Sculpting

Sculpting Basics

Being able to work with millions of polygons (up to 1 billion if using HD sculpting) is 
meaningless without an intuitive yet powerful way to sculpt those polygons. The award 
winning 3D Brush palette in ZBrush represents the most natural digital brushes system found 
in the digital sculpting world today. As a ZBrush artist you will be using the various sculpting 
brushes to bring your creations to life.

 Read an overview of sculpting brushes HERE 

 There are three main palettes that a ZBrush artist 
  will use when sculpting: 

 Brush Palette

 Stroke Palette

` Alpha Palette

You will find these three palettes at the top of your interface in alphabetical order. For quick 
access to these palettes you can also look to the left side of the ZBrush canvas where you’ll 
see a column of large thumbnails with the top three representing these palettes. (To a lesser 
degree you will also use Texture, Material and Color, which is why they have thumbnails on 
the left shelf as well.)

ZBrush includes dozens of brushes, designed for different needs. The most commonly useful 
ones are loaded into the Brush Palette at launch. Many more specialized brushes can be 

found by clicking the LightBox button and navigating to the Brush heading. 
Double-click any brush thumbnail in LightBox to immediately add it to your 
Brush Palette.

LightBox is the ZBrush browser that will pop up at the bottom of your ZBrush Interface when 
first launching ZBrush. Click on the Brush tab in LightBox to see more 3D Brushes.

Learn More about Basic Brushes HERE

http://www.pixologic.com/zbrush/features/07_brushes/
http://docs.pixologic.com/reference-guide/brush/brush-types/
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shortcuts: 
B = Open the Brush Palette pop-up window under cursor

 , (comma key) = Open/close LightBox

Imagery Courtesy of Scott Eaton

Brush Palette

This Brush Palette link will walk you through the most popular Brushes in ZBrush. 
However with over 200 brushes that ship with ZBrush we encourage you to explore and 
discover. As previously noted, additional 3D Brushes can be found in LightBox. 

While the Brush types are accessible 
through the pop-up window, you need 
to open the Brush palette to access the 
many available modifiers. For example, 
a new setting in ZBrush 4, Brush>Auto 
Masking>Topological, will control the 
brushes’ range of sculpting or painting 
ability based on the geometry flow of 
the mesh.

If you know the name of the brush you want, click on the 
Brush thumbnail to bring up the pop-up window. Next, type 
the first letter of the brush name. ZBrush will display only 
brushes starting with that letter, assigning logical letters or 
numbers to each brush’s icon. You can now press the key 
for the letter of the specific brush you want. For example, 
S T will always give the Standard brush. S W will give the 
StoneWall brush.

http://docs.pixologic.com/reference-guide/brush/
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Stroke Palette

This Stroke Palette link describes each Stroke type in detail. 
The Stroke controls how the 3D Brush is being applied to the 
surface of your Tool. For example, the Dots Stroke draws a series 
of very closely spaced dots to create a continuous line.  
The DragDot Stroke draws a single instance of your brush that 
can be dragged across the surface of the model before being 
precisely placed by releasing the mouse button.

Each Stroke type has a number of modifiers that can be  
applied to refine its performance.

http://docs.pixologic.com/reference-guide/stroke/
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Learn to create shoe treads 
with Gregory Callahan

Use the Gear3D primitive to  
create alphas with Joseph Drust

Create fuzzy hair with 
Ty Shelton

Imagery Courtesy of James Van Den Bogart

Alpha Palette

This Alpha  Palette link breaks down the whole palette. The Alpha is a grayscale image 
that is used as a mask by the brush to change its shape. This will allow you to sculpt details 
faster then you can say “alpha”.

For best results, alphas should be in 16-bit 
Grayscale PSD format. ZBrush can use 
lower bit-depth or RGB images such as JPG 
but the quality may not be as good.  
If you wish to put any alphas into the ZBrush 
4\ZStartup\Alphas folder (so that they are 
loaded into ZBrush at launch), the alpha 
MUST be 16-bit Grayscale PSD in order for 
ZBrush to recognize them.)

http://www.zbrushcentral.com/showthread.php?p=684124#post684124
http://docs.pixologic.com/user-guide/tips-tricks/joseph-drust/
http://docs.pixologic.com/user-guide/tips-tricks/ty-shelton/
http://docs.pixologic.com/reference-guide/alpha/
http://www.pixologic.com/docs/index.php/Tool_Palette
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Make the perfect rose with 
Magdalena Dadela

Create your next ShadowBox gear 
and gun with Geert Melis

Use ShadowBox to create your next 
vehicle with Steve Warner

Start your next bust with 
Mariano Steiner

Imagery Courtesy of Geert Melis

Create a Starting Base

Every sculpt must start somewhere. ZBrush has some amazing tools that will inspire you 
to create any base model from which you’ll build up your sculpture. With ShadowBox and 
ZSpheres, there is no limit to what you can create. 

ShadowBox

This ShadowBox link will teach you to rough out the shape of your mesh using any of the 
masking brushes previously discussed in the Getting Started section. ShadowBox takes the 

silhouettes that you paint on the box 
walls and uses that information to 
create a floating mesh in the center 
of the box.

See Shadowbox in action HERE

Shadowbox Resources:

http://www.zbrushcentral.com/showthread.php?t=91472
http://www.zbrushcentral.com/showthread.php?t=91748
http://www.zbrushcentral.com/showthread.php?t=91827
http://www.zbrushcentral.com/showthread.php?t=91734&page=2&pp=15
http://docs.pixologic.com/user-guide/3d-modeling/modeling-basics/creating-meshes/shadowbox/
http://www.pixologic.com/zbrush/features/zbrush4/sculpt-and-productivity/
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An Introduction to Dynamesh

Learn more about Dynamesh

Imagery Courtesy of Cezar Brandao 

ZBrush Artist: James Van Den Bogart

Dynamesh

DynaMesh is The New Base Mesh that has no 
limitations to what it can become. Starting from a 
sphere to create a character head is an easy process 
but DynaMesh will allow you to create a whole 
character from that very same sphere with no uneven 
geometry!

Consider what it’s like to work with clay. As you 
stretch clay out or add volume to it, the clay itself 
retains the same basic consistency and the same 
capacity for detail across its surface. DynaMesh 
brings that experience to the digital world.

The magic behind the DynaMesh is 
its ability to regenerate geometry in a 
blink of the eye, removing all stretched 
polygons by creating a surface optimized 
for sculpting and with equal distribution 
of polygons across the surface. Don’t be 
afraid to stretch your model to create legs, 
arms, columns, or whatever else comes to 
mind in your creative process. There are 
now no limits to what your starting point 
can evolve into.

Dynamesh Additions
Since its introduction, DynaMesh has served as an 
excellent concepting tool for developing the mesh that you 
will then sculpt. ZBrush 4R4 introduces refinements to give 
you even more freedom, such as being able to combine 
SubTools using DynaMesh and Boolean-type operators.
brings that experience to the digital world.

Learn more about the new  
additions to Dynamesh 

Dynamesh Additions

Learn about the new 
additions to Polygroups  

Polygroup Additions

www.pixologic.com/zclassroom/homeroom/lesson/dynamesh/#introducing-dynamesh
http://docs.pixologic.com/user-guide/3d-modeling/modeling-basics/creating-meshes/dynamesh/
http://www.pixologic.com/docs/index.php/Dynamesh
http://docs.pixologic.com/user-guide/3d-modeling/modeling-basics/creating-meshes/dynamesh/
http://docs.pixologic.com/user-guide/3d-modeling/modeling-basics/polygroups/
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QRemesher

Fully integrated into ZBrush , QRemesher is an easy to use 
automatic remeshing/retopologizing plugin. QRemesher 
does for your topology what UV Master did for UV mapping. 
It removes yet another creative barrier that often stands in 
the way of true artistic freedom. With QRemesher you can 
focus even more on the creative process of model creation 
and leave the technical hurdles behind! 

Unlike with traditional manual retopology, with QRemesher 
you can define a target polycount. This is very useful when 
you have restrictions on the number of polygons you can 
use, such as when you plan to take your work into a specific 
real-time engine. 

The minimum polygon count is limited to 1,000 polys. 
This is because fewer polygons would prevent automatic 
retopology from producing a usable result. If your budget 
requires fewer than 1,000 polygons you will need to use a 
manual retopology solution. 

In addition to the Target Polygon Count slider, there are three 
presets. With these you can automatically set the target to 
be half, equal to or double the number of polygons in your 
current model (or selection area). 

Learn more about the new  
additions to Dynamesh 

Dynamesh Additions

Learn about the new 
additions to Polygroups  

Polygroup Additions

Learn more about QRemesher

Learn more about Topology

http://docs.pixologic.com/user-guide/3d-modeling/modeling-basics/creating-meshes/dynamesh/
http://docs.pixologic.com/user-guide/3d-modeling/modeling-basics/creating-meshes/dynamesh/
http://docs.pixologic.com/user-guide/3d-modeling/modeling-basics/polygroups/
http://docs.pixologic.com/user-guide/3d-modeling/topology/qremesher/
http://www.zbrushcentral.com/showthread.php?t=91748
http://www.pixologic.com/docs/index.php/QRemesher
http://docs.pixologic.com/user-guide/3d-modeling/topology/topology-brush/
http://docs.pixologic.com/user-guide/3d-modeling/topology/topology-brush/
http://www.pixologic.com/zclassroom/homeroom/lesson/topology/
http://docs.pixologic.com/user-guide/3d-modeling/topology/topology-brush/
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Topology Brush

The Topology brush gives the ability to create new 
geometry with ease by drawing curves on the model. 
Where the curves connect new geometry is created. Unlike 
with the other Curve brushes, using the Topology brush, 
the curves can’t be edited on the surface of the model. 
They can only be deleted, extended by starting at the 
end of an existing point, of closed by connecting both 
extremities with a new curve. They can also be deleted by 
holding Alt while drawing a new curve to intersect the one 
you wish to remove. The Topology brush puts additional 
power in your hands to dictate the form of your creations.

Even though the curves may not be edited while having the topology brush 
active, it is possible to edit a curve created by the Topology brush (or QRemesher 
Guide brush) by picking any other Curve brush, making sure that Bend is on and 
completing your edits. Switch back to the Topology brush when done. 

Learn more about Topology Brush

Topology Brush Accessories

Imagery Courtesy of Carlos Vidal Torres

http://docs.pixologic.com/user-guide/3d-modeling/topology/topology-brush/
http://www.pixologic.com/docs/index.php/Topology_Brush
http://docs.pixologic.com/user-guide/3d-modeling/topology/topology-brush/
http://www.zbrushcentral.com/showthread.php?t=91748
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Mesh Fusion

ZBrush is able to fuse topology with new topology on an 
existing mesh. The mesh fusion function can be performed 
using QRemesher, the Insert and Insert MultiMesh brushes, 
and the Topology brush.

QRemesher Partial Mesh Retopology 

QRemesher has the ability to retopologize only a portion of your model. 
In this case it will automatically create the necessary connections to 
maintain mesh integrity with the original portions of the model. This is the 
fastest method of performing partial retopology.

Insert Mesh Fusion

Fuse different models together utilizing Insert Mesh brushes, creating 
clean topology to connect them. This operation will only affect the 
polygons located at the connecting borders while the rest of the model 
will remain unchanged. This process makes use of a polygon bridge 
between your inserted mesh and the connection points of the model you 
are connecting the new geometry too. This function will retain the original 
topology best.

Mesh Fusion and the Topology Brush

The replacement feature can also be combined with the Topology brush. 
The Topology brush is perfect for areas requiring an edit in topology. 
Using the power of curve mode, mesh fusion using the Topology brush 

ZBrush4R4 - Are You Ready?

Insert Mesh Replacement part 3 of 4

Insert Mesh Replacement part 4 of 4

http://www.zbrushcentral.com/showthread.php?170100-ZBrush-4R4-Are-YOU-ready
http://www.zbrushcentral.com/showthread.php?170100-ZBrush-4R4-Are-YOU-ready
http://www.pixologic.com/zclassroom/homeroom/lesson/insert-mesh/#insert-mesh-replacement-creature-part-4-of-4
http://www.pixologic.com/zclassroom/homeroom/lesson/insert-mesh/#insert-mesh-replacement-creature-part-3-of-4
http://www.pixologic.com/zclassroom/homeroom/lesson/insert-mesh/#insert-mesh-replacement-creature-part-3-of-4
http://www.pixologic.com/zclassroom/homeroom/lesson/insert-mesh/#insert-mesh-replacement-creature-part-4-of-4
http://www.pixologic.com/zclassroom/homeroom/lesson/insert-mesh/#insert-mesh-replacement-creature-part-4-of-4
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Insert Mesh Lesson

Environment with  
Tate Mosesian

When editing an existing curve, surface detection will allow you to 
conform the curve to the surface you are drawing on. This feature 
remains active when editing a curve, allowing you to change the 
path while still holding to the underlying surface. At the beginning 
and end of each curve you will see a green line indicator. These lines 
represent the normal direction (path) of the curve at those points.

Insert Mesh 

The Insert brush has become a major player in your ZBrush arsenal of features. 
Now that it also allows you to actually replace portions of a model, several new 
enhancements have been made. 

InsertMultiMesh 
To extend your creativity when using mesh insertion with both DynaMesh and/
or the mesh fusion feature, you can now use brushes which contain not only 
one, but a large panel of meshes, ready to be inserted. This makes it possible 
to create individual brushes with specific themes such as science fiction, 
mechanical, organic, flowers and more. 

Curve Mode Single Mesh 
ZBrush 4R4 introduces new controls to create more accurate curves, as well 
as for editing them after creating them.  

Curve Mode TriPart 
The Insert-type brushes have been enhanced with a new ability to insert 
copies of one mesh between two “end cap” meshes. For example, you can 
with a single stroke create a chain where its links are duplicated between two 
locks or stoppers 

Imagery Courtesy of Paul Gaboury

In addition to 
inserting a mesh as 
a negative, holding 
ALT while inserting 
a model can also 
stretch it.

http://www.pixologic.com/zclassroom/homeroom/lesson/insert-mesh/
http://www.pixologic.com/zclassroom/homeroom/lesson/insert-mesh/ http://
http://www.pixologic.com/zclassroom/homeroom/lesson/environments-with-tate-mosesian/
http://www.pixologic.com/zclassroom/homeroom/lesson/environments-with-tate-mosesian/
http://www.pixologic.com/zclassroom/homeroom/lesson/environments-with-tate-mosesian/


Do more, Do it in... Do more, Do it in...

33

Insert Mesh Lesson

Environment with  
Tate Mosesian

Learn More About Panel Loops

Learn More about Delete Loops and Align Loops

Introduction to Polish by Features

Panel Loops

With Panel Loops you can convert 
your model’s PolyGroups into panels of 
polygons with or without thickness, or 
even as extruded surfaces. The edges 
of these panels are created with a 
custom bevel around them defined by an 
editable profile graph curve. Borders will 
have clean polygons loops even on low 
resolution models. They can have inner 
or outer panels (or both) and can be created as an extrusion 
from the original surface or as entirely separate pieces.

Delete Loops

The new Delete Loops command analyzes your model’s topology 
based on a user-defined angle setting. With a single click it 
removes all unnecessary edge loops – polygons that don’t 
contribute to the shape of the model. 

Imagery Courtesy of Chris Carter

http://www.pixologic.com/zclassroom/homeroom/lesson/insert-mesh/
http://www.pixologic.com/zclassroom/homeroom/lesson/insert-mesh/ http://
http://www.pixologic.com/zclassroom/homeroom/lesson/environments-with-tate-mosesian/
http://www.pixologic.com/zclassroom/homeroom/lesson/environments-with-tate-mosesian/
http://docs.pixologic.com/user-guide/3d-modeling/hard-surface/panel-loops/
http://www.pixologic.com/docs/index.php/Panel_Loops
http://docs.pixologic.com/user-guide/3d-modeling/hard-surface/delete-align-loops/
http://docs.pixologic.com/user-guide/3d-modeling/hard-surface/polish-features/


Do more, Do it in...

34

Undo History Feature

Undo History Overview

Undo History
ZBrush now has a larger undo history for various operations, allowing you to go 
further back into your sculpting history to fix any mistakes -- even after reload-
ing your model in a new ZBrush session! While there is still a maximum number 
of undo’s which may be performed, this limit is now set at 10,000 which in most 
cases will be far in excess of what you might need. For clarity, you might think of 
this simply as a process history. 

In addition to the expanded undo/redo ability provided by this feature, the Undo 
History can be used to replay your creation process and save it as a movie. 

Undo History Movie

While sculpting with ZBrush, you are always turning around your model, zoom-
ing in and out or changing the model’s position to focus on a portion of your 
model. Simply playing back a recording of your sculpting session can be awk-
ward to watch due to all these movements. The Undo History feature has con-
trols to overcome this and make your recordings more enjoyable for viewers. In 
addition to the expanded undo/redo ability provided by this feature, the Undo 
History can be used to replay your creation process and save it as a movie. 

Imagery Courtesy of Paul Gaboury

http://www.pixologic.com/zbrush/features/undo-history/
http://www.pixologic.com/zbrush/features/undo-history/
http://docs.pixologic.com/user-guide/3d-modeling/undo-history/
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Grids and Reference Images

Grid
In ZBrush 4R4, the Grid feature is given new functionality, main-
ly to provide support for reference images. You can easily load 
your images for the front, side and top views to more easily cre-
ate artwork based on references.

A Floor Fill section has been added to the Grid options, located 
in the Draw palette. These settings allow you to load your refer-
ence images for the working planes you want to use. There are 
also settings to control visibility of these grids, the reference 
images, and the model itself. 

ZBrush can display a different image on each side of a grid 
plane. This is useful in situations such as when you need differ-
ent front and back reference images. 

Imagery Courtesy of Scott Spencer

http://docs.pixologic.com/user-guide/3d-modeling/reference-images/grids/
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ZSpheres

ZSpheres are an advanced ZBrush tool that is similar 
to working with a real-world maquette. With ZSpheres 
you can ‘sketch out’ a 3D model quickly and easily. 
Once the model has been formed using ZSpheres, it 
can be ‘skinned’ (the term for creating a mesh from it) 
for further sculpting. 

There’s nothing like ZSpheres in other 3D programs.
We’ll briefly touch on a few topics, and then leave you 
with some tutorials to study. 

http://docs.pixologic.com/user-guide/3d-modeling/modeling-basics/creating-meshes/zspheres/
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Imagine your next car 
with ZSketch

See ZSketch Smooth Showcased

Create your next ZSphere 
knot with Ty Shelton

Imagery Courtesy of Damien Canderle

shortcuts: 
Shift+A = Enter/exit ZSketch mode
B = Brings up ZSketch brushes when in ZSketch mode

ZSpheres can operate in several distinct modes:

Armature: This mode is like building the wire framework for a maquette. ZBrush 
then automatically creates the “clay” around that armature.

ZSketch: This mode is a step beyond the armature mode in that you put the clay 
on the armature yourself. You can use any model as the underlying armature by 
appending a Zsphere as a Subtool or just start with only one ZSphere. Learn the 
basics of ZSketch Brushes HERE.

Retopology: In this mode ZSpheres are used to change a base model’s 
topology on a point-by-point level. Alternatively, this mode can be used with 
another model as reference to create entirely new topology such as the remesh 
of a model or even form-fitting clothing.

http://www.pixologic.com/zclassroom/homeroom/lesson/additional-videos/#concept-car
http://www.pixologic.com/zclassroom/homeroom/tutorial.php?lesson=zspheres#smooth
http://www.zbrushcentral.com/showthread.php?t=91840
http://docs.pixologic.com/user-guide/3d-modeling/modeling-basics/creating-meshes/zsketch/brushes/
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Adding Complexity to a Character

Now that we have an understanding of what a Tool is in ZBrush we must speak about 
SubTools. SubTools are a way to add multiple meshes together to create a complete 
character, scene, vehicle or illustration. Not only do SubTools provide a way to better 
organize your model, they also serve to break your work into bite-sized chunks. While your 
computer won’t be able to handle a single model of 40 million polygons, it certainly can 
handle a model comprised of eight SubTools with 5 million polygons each.

With SubTools it’s very easy to create accessories for a character or add the little things 
and fine details that bring a scene to life.

In essence, SubTools are another Tool being linked to the selected Tool by clicking on 
Append or Insert in Tool > SubTool Sub-Palette.

http://docs.pixologic.com/reference-guide/tool/polymesh/subtool/
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Check out the ZBrush bike 
in this video 

Learn to create a motorcycle with 
Mesh Extract PART 1 (30 min)

Learn to create a motorcycle with 
Mesh Extract PART 2 (30 min)

Imagery Courtesy of Christian Fischer

Mesh Extract

Mesh Extract is a good way to create clothing, tools, a helmet, machine 
parts, (you name it), quickly by using masking. When the mesh is extracted a 
new SubTool is automatically added to the selected Tool. This new SubTool 
shares the same topology as the model from which it was derived, with only 
the edges being different. 
Note: An extracted mesh can also have various degrees of thickness.

Quick tip: In ZBrush 4r4 an 
extracted mesh retains the mask 
that was used to create it. Press 
Tool > Masking > Clear to remove 
the mask so that you can begin 
sculpting the extracted mesh.

Learn the basics of using Mesh Extract HERE

Learn to sculpt a basic head HERE

http://www.zbrushcentral.com/showthread.php?t=095181
http://www.zbrushcentral.com/showthread.php?t=95181&page=6&pp=15
http://www.zbrushcentral.com/showthread.php?t=95181&page=11&pp=15
http://www.pixologic.com/zbrush/features/02_MeshExtract/
http://www.pixologic.com/docs/index.php/Mesh_Extraction_with_Masking
http://docs.pixologic.com/user-guide/3d-modeling/modeling-basics/creating-meshes/mesh-extract/
http://www.pixologic.com/docs/index.php/Sculpting_a_Head
http://docs.pixologic.com/getting-started/sculpting-a-head/
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FiberMesh™

ZBrush 4r4 brings a new specialized mesh generation 
tool: FiberMesh™. You may already be familiar with 
the Fiber material from previous versions of ZBrush. 
FiberMesh is different because it is not a render process. 
Instead, FiberMesh creates real geometry on the fly 
which is added to the existing model as a new SubTool. 
 
You will find FiberMesh in the Tool >> Fibers sub-palette. 

Depending on your settings within the Fibers sub-palette, 
you can generate totally different shapes for fibers, hair, 
fur and even vegetation. 
Thanks to these fibers 
being a real geometry, 
you then have the ability 
to sculpt your hairs with 
ZBrush’s powerful feature 
set. This includes the 
default sculpting brushes, 
Masks, TransPose, etc. 
as well as being able to 
paint them through the PolyPaint system. ZBrush 4r4 
also introduces a number of “Groom” brushes designed 
specifically for use with the FiberMesh feature. 

Of course, because these fibers are real geometry, they 
are also able to be exported to your application of your 
choice. Export the fiber geometry with or without UVs 
where each fiber will allow a texture to be applied to the 
individual fibers.  
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Imagery Courtesy of Daniel Williams

Imagery Courtesy of Tsvetomir Georgiev

FiberMesh™

ZBrush 4r4 brings a new specialized mesh generation 
tool: FiberMesh™. You may already be familiar with 
the Fiber material from previous versions of ZBrush. 
FiberMesh is different because it is not a render process. 
Instead, FiberMesh creates real geometry on the fly 
which is added to the existing model as a new SubTool. 
 
You will find FiberMesh in the Tool >> Fibers sub-palette. 

Depending on your settings within the Fibers sub-palette, 
you can generate totally different shapes for fibers, hair, 
fur and even vegetation. 
Thanks to these fibers 
being a real geometry, 
you then have the ability 
to sculpt your hairs with 
ZBrush’s powerful feature 
set. This includes the 
default sculpting brushes, 
Masks, TransPose, etc. 
as well as being able to 
paint them through the PolyPaint system. ZBrush 4r4 
also introduces a number of “Groom” brushes designed 
specifically for use with the FiberMesh feature. 

Of course, because these fibers are real geometry, they 
are also able to be exported to your application of your 
choice. Export the fiber geometry with or without UVs 
where each fiber will allow a texture to be applied to the 
individual fibers.  

See Joseph Drust’s Experimentation 
with FiberMesh

Micro Mesh

Micromesh, joins the already feature rich list 
inside ZBrush 4r4. It will allow for ZBrush’s 
rendering system to replace a generated 
FiberMesh, or a models individual polygons 
with any other 3d mesh. That being said, 
you can already start to imagine the creative 
potential at hand. This new feature will no 
doubt open doors to previously undoable 
operations and design elements. Now you 
can “grow” complex plants with the help 

of FiberMesh or place real scales on your 
creatures. 

Amazingly, MicroMesh will only be 
displayed at render time. 

FiberMesh cont.

FiberMesh geometry is optimized for 
performance which and includes specific 
attributes which let thethat allows the 
ZBrush groom sculpting brushes know that 
they are being used on a FiberMesh. Any 
3D brush can be adjusted to edit fibers with 
new settings available in the Brush Palette. 
However, if you do something that changes 
the topology -- like slicing the fibers or 
adding subdivision levels – ZBrush converts 
the FiberMesh into a classic PolyMesh3D. 
From that point forward, the sculpting 
brushes will behave exactly like they would 
for any normal mesh object. 

Learn the basics of using FiberMesh HERE

FiberMesh in ZClassroom HERE

http://www.zbrushcentral.com/showthread.php?165716-FiberMesh-Hair-Testing-Experimentation
http://www.pixologic.com/docs/index.php/Mesh_Extraction_with_Masking
http://www.pixologic.com/zclassroom/homeroom/lesson/fibermesh/#fibermesh-basics
http://www.pixologic.com/zclassroom/homeroom/lesson/fibermesh/#fiber-essentials


Noisemaker

Surface Noise was first introduced in ZBrush 3.5 
and provided a way to display procedural effects 
on the surface of your model. Enhancements in 
subsequent releases provided many new ways to 
generate the surface noise as well as the ability to 
convert this noise into actual geometry. 
Because this noise is procedural, you can 
apply advanced modifications to both topology 
and PolyPaint without altering your current 
model. However, at any time you can convert 
the rendered effect into actual geometry and/
or PolyPaint – either on the entire model or to 
specific portions using Masks to protect the rest 
of the surface. 

ZBrush v introduces the NoiseMaker 
Plugin. This adds a full set of powerful 
noise generators to the existing 
NoiseMaker functions from ZBrush 4R2. 
The key difference to the noise created by 
NoiseMaker is that it is being generated in 
3D instead of 2D. 
Most of these generators have common 
and specific settings, which produce almost 
instantaneous visual results. The workflow 
for using Surface Noise is the same as 
from ZBrush 4R2 except that you can now 
replace the default noise with one that is 
generated by the NoisePlug settings. 

Click here to see the Noisemaker workflow 
of Maxence Fleuret
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Click to see Geert Melis 
working with Noisemaker

ZClassroom Noisemaker tutorials Paint It Up

http://www.zbrushcentral.com/showthread.php?161166-ZBrush-4R2-Beta-Testing-By-Maxence-Fleuret
http://www.zbrushcentral.com/showthread.php?161166-ZBrush-4R2-Beta-Testing-By-Maxence-Fleuret
http://www.zbrushcentral.com/showthread.php?161159-ZBrush-4R2-Betatesting-By-Geert-Melis
http://www.pixologic.com/zclassroom/homeroom/lesson/noisemaker/#noisemaker-basics


ZBrush v introduces the NoiseMaker 
Plugin. This adds a full set of powerful 
noise generators to the existing 
NoiseMaker functions from ZBrush 4R2. 
The key difference to the noise created by 
NoiseMaker is that it is being generated in 
3D instead of 2D. 
Most of these generators have common 
and specific settings, which produce almost 
instantaneous visual results. The workflow 
for using Surface Noise is the same as 
from ZBrush 4R2 except that you can now 
replace the default noise with one that is 
generated by the NoisePlug settings. 

Do more, Do it in...
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Follow Yiannis Tyropolis in making your 
next cartoon character

Create your next comic book in 
ZBrush with Olivier Thill

Imagine your next pin up like Michal 
Suchanek has here

Your next masterpiece is easy to conceive with 
ZBrush just as Alexey Kashpersky did with his 
piece called “Dream”

Imagery Courtesy of Alexey Kashpersky

Daniel Crossland

Painting With No Boundaries

Now that you have a sculpted model, let’s 
look at how we can add color to your creation. 
There are four major tools explained below 
that you can use for painting in ZBrush. 

Let’s also not forget that ZBrush has full 2D & 
2.5D capabilities that will allow illustrators to 
create images with depth, color, material and 
light information. Here is a great Illustration 
link to learn more about how ZBrush is used 
for this purpose.

There are many great artists that use ZBrush 
for Illustration. Some work entirely with 
ZBrush’s 2.5D “paint” while others also 
incorporate 3D models into their scenes as 
pixols. Once a 3D model has been “snapshot” 
to the canvas it becomes exactly the same as 
if it had been painted with brushes; the pixols 
integrated perfectly with anything else that is already in the scene. We have provided several 
links here so that you can see what artists are doing with ZBrush to bring life to a 2D static 
image.

http://www.zbrushcentral.com/showthread.php?t=95227&page=1&pp=15
http://www.zbrushcentral.com/showthread.php?t=093536
http://www.zbrushcentral.com/showthread.php?t=070688
http://www.zbrushcentral.com/showthread.php?t=68810&page=1&pp=15
http://www.pixologic.com/zbrush/features/17_2_5D/
http://www.pixologic.com/zbrush/features/17_2_5D/


Do more, Do it in... Do more, Do it in...

45Imagery Courtesy of Daniel Williams

Now that you have seen how powerful ZBrush’s sculpting tools are, let’s walk through the 
basics of bringing color to your sculpts. There are four major ways to texture/paint in ZBrush:

• PolyPaint

• Projection Master

• ZAppLink your work to (and back from) Photoshop

• SpotLight

Before we break into each of these sections lets make sure you understand the parts of the 
User Interface that apply to painting. First, look immediately above the canvas at what is 
called the Top Shelf. Here you will find the following switches and sliders:

• Mrgb - With Mrgb turned on your brush strokes will apply the  
selected color and material to the canvas or your model.

• Rgb - With the Rgb button selected you will only apply color when your 
brush is over the surface.

• M - With this button selected you will only apply the selected Material to 
the sculpt when the brush is applied.

• Rgb Intensity - Controls the amount of color being applied to the surface 
with 100 representing 100% intensity and 0 representing that no color 
is applied. You can also build up your color information, for example, 
painting a stroke at 50 intensity and then painting over that spot with 
another stroke at 50 intensity will result in 100% color intensity.

Note: These modes are independent of the Zadd/Zsub and Z Intensity options. 
This means that any brush stroke can both paint and sculpt at the same time,  
if you would like.
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There are four palettes that, when combined, control the colors being applied to your 
surface:

• The Color Palette - This is where you select the base color you wish to 
apply to your surface when Rgb or Mrgb is on.

• The Draw Palette - This palette has your Mrgb, Rgb, M switches and 
the Rgb Intensity Slider. (These are the same elements that are also 
located on the Top Shelf.)

• The Material Palette - This palette is used to select which material you 
would like to apply to the surface. A material tells the rendering engine 
what to do when light reaches a surface. This means that your material 
will modify whatever color has been painted on the model or canvas.

• The Texture Palette - This palette will allow you to import/export 
textures that you wish to apply to your character or brushes. When 
applied to a model (using the Tool > Texture Map menu), texture hides 
any color that has been painted onto the model previously.

http://docs.pixologic.com/reference-guide/color/
http://docs.pixologic.com/reference-guide/draw/
http://docs.pixologic.com/reference-guide/material/
http://docs.pixologic.com/reference-guide/texture/
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Su Yeong Kim

Lighting also plays a role in determining the colors you’ll see on your 
surface. As you rotate your model, the shadows interact across its surface to 
dynamically lighten and darken the colors. Lighting is controlled through the 
Light palette unless you’re using a MatCap™ material. (In which case the 
lighting is baked into the material itself.)

A simple equation to understand how ZBrush’s rendering engine 
creates the colors that you see on the canvas is:

Color or Texture + Material + Lighting = Rendered Color

Easy access to the Texture, Material and Color palettes is found on the Left 
Shelf of your interface. This will provide a quick way to build your paint 
brushes!
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When you first start with your character the color and material are in what is called a “live” 
state. As you switch to a different color or material you will see your character’s color and 
material change right before your eyes. 

To begin painting multiple colors and/or materials onto your 
surface, let’s assign them to your character. This is done by “filling” 
the object.

Once you have a material that you would like to permanently apply 
to your character just make sure that M is on at the top of your 
interface and then click to Color > Fill Object. 

This PolyPaints the entire model with a base coat of the selected 
material. If you select a new material your character will keep the 
Filled material assigned and nothing will change on the model. You 
can now use the brushes to paint other materials to different parts 
of your model.

Note: To remove PolyPainted materials from your model select 

the FlatColor material, turn on M and press  

Color > Fill Object again.

Now that we have a material assigned, let’s fill your character with White color. Make sure 
White is selected in your Color Swatch, activate Rgb on the Top Shelf (or in the Draw 
palette) and then click Color > Fill Object.

Of course, if you wish to fill the Color and Material at the same time just make sure to have 
Mrgb active when doing a Color > Fill Object.

What this allows you to do is paint with just color, with material only, or with both at the same 
time. Just like with materials, once you have a character filled with a color any other color 
you select can only be applied to the surface with a brush stroke. This is much like how a 
painter applies paint to a canvas – the Fill Object operation prepares the object so that you 
can then paint it with your brushes.

Go ahead and give it a try!
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shortcuts: 
Hold C = As you move your cursor around the screen,  
        the color beneath the cursor will be selected

V = Switch between Main color and Secondary color

Imagery Courtesy of Christopher Nichols

Christopher Nichols

PolyPaint
Now that we have a basic understanding of color and 
material let’s talk about what this PolyPaint term means. 
PolyPaint is a revolutionary new way to paint a model in 
ZBrush. PolyPaint will allow you to directly paint on the 
surface of your model with no UVs needed.

What PolyPaint technically boils down to is a way to 
assign color and/or material to a model’s points. Since 
ZBrush is capable of working with millions of polygons in 
real time, you can achieve a resolution that meets (or even 
exceeds!) that of textures – and do it without UV mapping 
your model. 

This is ideal for coloring models that will be rendered in ZBrush because it completely 
removes the technical aspect of assigning UV’s and painting textures from the equation. It’s 
also quite useful in a production environment since PolyPaint can easily be converted to a 
texture. You can sculpt and paint a “hero” model – all before even thinking about topology or 
UV mapping. You can also change topology or UV’s -at any time- without losing any detail 
previously PolyPainted. ZBrush gives you incredible artistic freedom!

PolyPaint is like holding a paint brush with which you freely apply paint to your character. 
What’s more, because PolyPaint is done on the 3D surface rather than a 2D flat map, you 
don’t need to worry about compensating for seams or UV distortion. Paint what you want to 
see and let the computer worry about the technical stuff!

Learn your basics of PolyPainting HERE

Learn more PolyPainting HERE

Learn to PolyPaint a head HERE

http://www.pixologic.com/zbrush/features/16_PolyPaint/
http://docs.pixologic.com/user-guide/3d-modeling/painting-your-model/polypaint/
http://docs.pixologic.com/user-guide/3d-modeling/painting-your-model/polypaint/using-sculpting-brushes/
http://docs.pixologic.com/user-guide/3d-modeling/painting-your-model/polypaint/painting-a-head/
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shortcuts: 
G= Will drop the tool to the canvas and  
 will pick tool back up when completed

Use Projection Master to make a 
building with Sebastien Legrain

Imagery Courtesy of Christopher Brandstrom

Using Projection Master

Projection Master is an intuitive approach unique to ZBrush that will allow you as an artist 
to drop your 3D mesh to the canvas as pixols so that you can use the 2.5D brushes found 
HERE. Once you’ve finished painting color, material and/or depth, use Projection Master to 
pick the model up from the canvas again. Everything you have painted in a 2.5D mode is now 
automatically projected onto the 3D surface.

Think of Projection Master as a supplement to your sculpting process - projecting color and 
material attributes to your model.

Here is a quick overview of Projection Master.

http://www.pixologic.com/zclassroom/homeroom/lesson/projection-master/#sebastien-legrain-inro
http://docs.pixologic.com/reference-guide/tool/2-5d-tool/
http://docs.pixologic.com/user-guide/3d-modeling/sculpting/projection-master/


Do more, Do it in... Do more, Do it in...

51Imagery Courtesy of Alvaro Buendia

“ZAppLink” Your Work to Photoshop

ZAppLink is a plugin developed by Pixologic to allow 
you the artist to send your model over to Photoshop  
(or any PSD-capable image editor) so you can use all its 
brushes, filters and other features on your model. In a 
way, ZAppLink turns Photoshop into a ZBrush plugin!

An excellent example of how ZAppLink can benefit you is how it can be used to add text to 
your surface using Photoshop text editor.

ZAppLink is similar to Projection Master in that it takes snapshots of your model. Like 
Projection Master drops these snapshots of your model onto the ZBrush canvas for 
modifying, ZAppLink will send the model’s snapshots to Photoshop. Once you paint on the 
model’s layer in Photoshop and save the file (by pressing CTRL+S) you are able to switch 
back over to ZBrush (Alt+Tab in Windows, Command+Tab in Macintosh). You’ll see a 
confirmation dialogue box, your paint will then be projected onto the model.

Get started with ZAppLink Basics HERE

ZAppLink is a plugin that you must install into your ZBrush 4\ZStartup\ZPlugs folder. You 
more information about the ZApplLink plugin HERE. 

http://docs.pixologic.com/user-guide/3d-modeling/painting-your-model/zapplink/
http://www.pixologic.com/zbrush/downloadcenter/zplugins/
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shortcuts: 
Shift+Z = Turn on/off SpotLight
Z = In/out of SpotLight edit mode

See how Daniel Crossland uses SpotLight 
to texture his little bunny

See how Steve Warner uses tank 
images to create his tank

Imagery Courtesy of Steve Warner Imagery Courtesy of Gregory Callahan

SpotLight

SpotLight was introduced in ZBrush 4 to give you the artist a whole new world for texturing 
your characters. SpotLight allows you to float one or more textures in front of the ZBrush 
canvas to edit or manipulate them in a variety of ways. You are then able to use any of the 
Brushes to project from the floating texture onto the model behind it. SpotLight makes 
texturing fun and easy! 

SpotLight is also not limited to the textures that you have on your machine. Using LightBox’s 
WWW tab , you can search for image references directly from the internet, preview them in 
LightBox, then add the ones you like to SpotLight with a simple double-click!

Learn what every button can do for you in these SpotLight Videos.

SpotLight is more than a texture/painting tool. SpotLight will also apply sculptural changes 
to your mesh if Zadd is active, therefore allowing you to texture, paint and sculpt at the same 
time. Many artists also use SpotLight for “reference sculpting” and much more.

http://www.zbrushcentral.com/showthread.php?t=91618
http://www.zbrushcentral.com/showthread.php?t=91827
http://www.pixologic.com/zclassroom/homeroom/tutorial.php?lesson=spotlight
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Norman Schaar

Posing Your Characters 
 
Alright, now that we have learned to sculpt and paint a character, we need to put some feel-
ing into our creation. ZBrush allows you to pose a character into multiple positions so that 
your finished image has a dynamic feel.

There are four major tools that will bring life your character. These tools are: 

• Mannequins

• TransPose (with or without TransPose Master)

• ZSphere Rigging

• Timeline

Once again ZBrush breaks the technical boundaries. Using 
our simple and nontechnical posing system, artists can 
now experience and explore multiple ways to bring their 
digital creations to life without leaving ZBrush. The following 
sections will take you through the powerful posing tools 
available in ZBrush.

Mannequins

ZBrush 4 introduces a new tool for an artist to quickly hash 
out any singular or multiple pose(s) within a scene. With 
the new Mannequin system you can begin to pose by first 
establishing the form. What a great tool for your concepts!

At any time, you can search for a dynamic pose and then 
sculpt directly onto that posed Mannequin. This tool is 
not just for a simple character but can also be used for a 
quadruped or any other creature within a scene.

Learn the basic navigation of Mannequins from the videos 
under the Concept Creation section HERE

http://www.pixologic.com/zbrush/features/zbrush4/feature-list/


Imagery Courtesy of Maximilian G. Vogt
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shortcuts: 
W = Move mode
E = Scale mode
R = Rotate mode

Transpose Line 
 
The transpose line has evolved to better meet the needs of the art-
ist. Several new actions have been added to Transpose which will 
enhance your interactive mesh deformations as well as improving 
manipulation of your meshes.In addition to the expanded undo/redo 
ability provided by this feature, the Undo History can be used to replay 
your creation process and save it as a movie. 

You can use Transpose to easily move one SubTool relative to another 
and/or manipulate a SubTool, along with changing its shape, gesture 
or form. Learn the basic controls of Move, Scale, and Rotate using 
TransPose. The Move, Scale, and Rotate icons found at the top of 
your interface will activate TransPose Mode and display the Action 
Line. Understand the Action Line HERE.

 The TransPose Line (or Action Line) also makes it possible to have a 
digital caliper within the ZBrush document. Once you have defined the 
scale, the Action Line can quickly and easily show you the distance 
between any two points. Learn how to manipulate your scale settings 
HERE.

http://docs.pixologic.com/user-guide/3d-modeling/posing-your-model/transpose/
http://docs.pixologic.com/user-guide/3d-modeling/posing-your-model/transpose/action-line/
http://docs.pixologic.com/user-guide/3d-modeling/posing-your-model/transpose/scaling/
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Learn about the new Transpose Line

Imagery Courtesy of Tomasz Strzalkowski 

Axis Selectors 

In addition to the default TransPose action line, world axis indicators have been 
added. By clicking on the small circle at an axis extremity you can align the ac-
tion line along the corresponding axis. 

Orientation 
In some circumstances it is useful to orient Transpose exactly to the surface 
normal. For example, having the action line perpendicular to the surface can be 
useful for doing a clean extrusion. It is also quite useful when using an Insert 

brush – both for inserting the shape as well as for manipulating it after insertion.

Flatten a Surface 
The Transpose line in Move mode lets you flatten the model along its action line 
axis. This is done by dragging the inner circle located at the root of the universe 

three axis indicator. 

Inflate a Surface 
The Transpose line in Move mode lets you inflate the model along its action line 
axis. This is done by right-click dragging the furthest circle away from the uni-
verse three axis indicator. Hold the cursor over the red ring then right+click and 
drag outwards.

Insert and Edge Loop 
Edge loop insertion using TransPose can now be done in Move or Scale mode. 
In Move mode it works as before. In Scale mode it adds a new ability to quickly 
create topology inserts on a model without subdivision levels rather than a 
simple extrusion. 

While Scale mode is active, holding the CTRL key and dragging the action line’s 
inner middle circle will create an edge loop on the boundary of the non-masked 
part of the model. 

http://www.pixologic.com/zclassroom/homeroom/lesson/transpose/
http://www.pixologic.com/zclassroom/homeroom/lesson/transpose/
http://www.pixologic.com/zclassroom/homeroom/lesson/transpose/


Imagery Courtesy of Michal Suchanek
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TransPose Master

Now we know that most characters will have several SubTools filled with weapons, clothing, 
gear and anything else you might imagine. Since TransPose works with a single SubTool, 
Pixologic has developed a plugin called Transpose Master which allows you to pose all your 
SubTools at once.

TransPose Master creates a proxy mesh that serves as a stand-in for your multi-part model. 
You then TransPose the proxy mesh, after which TransPose Master will analyze your changes 
and apply those back onto the original model.

This is another plugin that must be downloaded from our Download Center.  
All instructions and documentation can be found in the zip file.

http://www.pixologic.com/zbrush/downloadcenter/zplugins/


Imagery Courtesy of Bryan Wynia
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Steve Jubinville

ZSphere Rigging

We have already discussed how to use 
ZSpheres to create a base mesh, however, 
there is so much more to this powerful tool. 
Found only in ZBrush, ZSpheres can also be 
used as a rigging tool.

You can begin by creating an underlying rig 
(or skeleton) for your character. Then with 
a single click, ZBrush binds your character 
to this skeleton for posing. Posing the 
ZSphere skeleton will automatically pose the 
character that’s bound to it.

Learn the basics of setting up a rig HERE.

See how to pose and transfer a high 
resolution sculpt to your pose HERE

Now I know what you’re thinking... what if I have multiple SubTools to pose?  
This is where the ZSphere Rig Setting in TransPose Master will allow you to pose multiple 
SubTools with a rig.  

See TransPose Master Rigging in action HERE 

http://docs.pixologic.com/user-guide/3d-modeling/posing-your-model/rigging/
http://www.zbrushcentral.com/showpost.php?p=764822&postcount=3
http://www.zbrushcentral.com/showpost.php?p=764823&postcount=4
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shortcuts: 
All Timeline Short cuts can be found by holding down 
the CTRL key as you scroll over the Show button 
under the Render>Timeline Sub-Palette.

Jump deeper into Timeline with these 3 
videos on Timeline Animation

See how to bring subtle movement to a 
character with Marco Splash Plouffe

See Dave Wolf bring a heart to life 
with Timeline

Timeline

Have you ever created an amazing model but wanted to view it in motion in order to check 
your sculpted character, present it to your art director or simply create your next demo reel?  
How about giving a little bit of movement to a character by simply having him breathe and 
maybe fidget a bit? Or how about having a car race across the screen? At some point, we all 
want to put motion into our work quickly and with the simplest approach. 

Timeline will allow you to do just this. See the many ways Timeline will work with TransPose 
and ZSphere Rigging to bring a scene to life HERE. 

Watch all 3 movies. You won’t regret it.

Timeline can also be used as a basic inventory system allowing you to key just about 
anything in your ZBrush workflow. For example, you can hide parts of your model and create 
a key frame. Any time you return to that key frame on the Timeline, ZBrush will hide those 
parts of the model again. 

Learn the basics of using Timeline HERE.

http://www.pixologic.com/zbrush/features/zbrush4/paint-and-show/
http://www.zbrushcentral.com/showthread.php?t=91630
http://www.zbrushcentral.com/showthread.php?t=91741
http://www.zbrushcentral.com/showthread.php?t=086043
http://docs.pixologic.com/user-guide/movies/timeline/


Imagery Courtesy of Mariano Steiner

Polishing   
Your Work

Chapter 5:
Chapter 1

Start

Chapter 2

Chapter 3

Chapter 4



Do more, Do it in...

61

See how Yiannis Tyropolis uses Lights  
and BPR to render out his character

Imagery Courtesy of Ian Joyner

Polishing   
Your Work

Render Settings

Now that you can sculpt, paint, and pose in ZBrush, let’s create an image that is going to 
knock your socks off. ZBrush has three rendering systems that can be used to render  
an image. 

The three render systems are:

Preview Render 
This render system applies a real-time render to your character as you sculpt so 
that you may have much more realistic interaction with your character. Any time 
you are sculpting, painting or PolyPainting in ZBrush, you are using the real-time 
Preview render. If you have used a different renderer, ZBrush will automatically 
switch back to Preview as soon as you interact with a mesh or the canvas.

BPR (Best Preview Render)
This is a 3D render system that will create realism with multiple rendering 
passes. This render system will allow you to render models with real 3D 
Shadows, Ambient Occlusion, Multiple SubTool Transparency, 3D Fibers and a 
SSS pass. Learn about the various settings HERE.

Note: BPR requires that a model be in Edit mode on the canvas. It is specifically 
designed for rendering polygons rather than pixols.

Best Render
This render system is essential to any illustrator to bring a 2D/2.5D image alive. 
Learn more about render modes HERE. For best results, create your illustration 
at twice the desired export size and turn on AA Half mode (on the Right Shelf) 
before or after rendering.

http://www.zbrushcentral.com/showthread.php?t=95227
http://docs.pixologic.com/user-guide/materials-lights-rendering/rendering/bpr/
http://docs.pixologic.com/user-guide/materials-lights-rendering/rendering/
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Learn more about Posterization
and Step Curves

Posterize
ZBrush puts celshading at your fingertips with 
new Posterize render features. Give your models a 
new look with full control over gradients and steps 
in real time!

Posterization in ZBrush is computed in different 
ways depending on your needs. You can use it in 
3D and build your desired effect directly onto your 
model, or it can be applied as a 2D effect to your 
renders in conjunction with BPR (Best Preview 
Render) filters. 

Taking this concept further, BPR Posterization can 
dynamically unify your model with a background 
image. 

Step Curves
In ZBrush Posterization can also be applied to Materials and Curves via 
the curve modifiers settings. The Posterization functionality extends to 
Shader Channels, Sculpting Brushes, Alpha curves and Auto Masking. 

Outline
The Outline function applies an illustrative touch to your final 
image. Outline also works with the Material Mixer and as a 
post render effect in conjunction with BPR filters.

Imagery Courtesy of Oliver Milas

http://docs.pixologic.com/user-guide/materials-lights-rendering/posterization/
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Ryan Trammell

There are several other controls that will really make a difference in any render. Make sure  
to play with these various settings when using Best Render and BPR to create a more  
realistic render.

• Depth Cue – Gives your render a depth-of-field look. Learn more HERE.

• Fog – Create moods like darkness, underwater or flying through the atmosphere. 
Learn more HERE.

• Environment – Brings reflective materials to life. Learn more HERE.

• Render Adjustments- After rendering you can make some subtle adjustments 
to your image. Learn more HERE.

http://docs.pixologic.com/user-guide/materials-lights-rendering/rendering/depth-cue/
http://docs.pixologic.com/user-guide/materials-lights-rendering/rendering/fog/
http://docs.pixologic.com/user-guide/materials-lights-rendering/rendering/environment/
http://docs.pixologic.com/user-guide/materials-lights-rendering/rendering/adjustments/
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Follow Igor Catto through the simple 
features of rendering

Take advantage of ZBrush  
materials with Olivier Thill Comic

Learn how easy it is to render damaged 
metal with Edward Fleissig

Use Fibers to create fur/grass/hair and so much 
more with Magdalena Dadela

Imagery Courtesy of Edward Fleissig

Lights

Of course you cannot render without Lights. The ZBrush Light system is a completely user-
friendly system. Learn more about the Light Palette HERE.

Small note: Light Colors will only render out with Best Render. You can also 
complete a Best Render first and then run a BPR to take advantage of both 
rendering systems on the same model.

http://www.zbrushcentral.com/showthread.php?t=91685
http://www.zbrushcentral.com/showthread.php?t=093536
http://www.zbrushcentral.com/showthread.php?t=96366&page=1
http://www.zbrushcentral.com/showthread.php?t=91472
http://docs.pixologic.com/reference-guide/light/
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LightCap™

ZBrush 4r4 introduces 
the LightCap Designer: 
a real-time material light 
modifier. In astonishingly 
little time you can create 
scene lighting from an 
environment, create lights 
with alpha shapes applied 
and even add texture to a 
light to fit the needs of your 
render.

You can even create lights 
and then use the LightCap 
Designer to convert these 
to an environment for your 
render, resulting in more 
accuracy and allowing more 
creativity in your process.

Lightcap Bat Creature Rendering 
Technique by Mariano Steiner

Environment Map Support to 
generate Lightcaps

Rendering with Lightcap 

Learn more about Lightcap: 

Rotate With Object

Rotate With Object mode, located in the Light >> Background sub-palette (activate by 
default) synchronizes your mesh orientation with the background. The result is that whenever 

do a camera rotation, the background will follow. This function is enabled by default. 

Snapshot

With new Rotate With Object ability, you can apply your reference image as a Background 
and snapshot (Shift+S) a grid. You can even snapshot your mesh to the background 
panorama, storing all the views of your choice as one background.

ZBrush 4R4 Background Updates

The Light >> background function provides new controls which will be very useful when 
working with animations, including ZBrush 4R4’s History Animation feature.

Check out 4R4 Background Updates

http://www.zbrushcentral.com/showthread.php?161210-ZBrush-4R2-Betatesting-By-Mariano-Steiner
http://www.pixologic.com/zbrush/features/zbrush4r2/rendering/
http://www.pixologic.com/zclassroom/homeroom/lesson/lighting/#lightcap
http://docs.pixologic.com/user-guide/materials-lights-rendering/lights/lightcap/
http://www.pixologic.com/docs/index.php/4R4_Background
http://docs.pixologic.com/reference-guide/light/background/
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